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1 Introduction 
The Text Alert Data Monitoring and Logging system can monitor up to 6 analogue / digital inputs 
and sends SMS alarm messages to up to four mobile phones including a central station.  
Additionally, the system can log the value of six inputs at 1 minute intervals and send a daily log 
to a central PC. 
 
The system also has 4 relay outputs which can be triggered on alarms or be switched on and off 
by text message.  An optional PIR motion sensor is also available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sends daily 
log file to 
central PC 

Alarm messages to 
4 mobile phones 

24 Vdc 
Supply 

6 Analogue / Digital 
Inputs 

2 Digital 
Inputs 

Optional PIR 
motion sensor 

Incoming text 
messages can switch 
relays on,  
obtain status,  
turn system on or off, 
request log file 

Four relay outputs controlled by in-
built logic or text message 

1.1 Quick Start 

1.1.1 Alarm Monitoring System 
Wire in analogue / digital inputs and outputs using PCB links to set input types (see pages 6 to 7) 
Wire up 24 Vdc power supply (11.1 to 30Vdc) 
Install GSM Data software onto a PC (see page 9) 
Configure software and download to Text Alert (see pages 9 to 15) 
Turn Text Alert to ON mode (see page 24) 
Text Alert will now monitor the inputs and send SMS alarm messages to the selected phones.  

1.1.2 Data Logging Option 
Configure data logging options and download into the Text Alert (see pages 13 to 15)  
Connect modem to PC using the RS232 cable provided. 
With the modem switched on start the GSM data receiver program. 
The system is now ready to receive daily log files or to request intermediate log files. 
Note: The GSM Data Receiver program must be running in order to receive data files.  It can be 
minimised. 
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1.2 Phone System 
The unit includes a SIM card for the Vodafone network.  This has the largest coverage in the UK, 
but there may be gaps in the coverage.  If you cannot link to the Vodafone network it should be 
possible to use another service provider, please contact us for details.  The SIM card provided is 
a pay-as-you-go service.  So for each text message that the system sends the balance on the 
account is reduced.  The rate for each message is likely to change but is currently about 12p per 
text.  When the balance on the account is low it can be topped up at usual locations, phone 
shops, supermarkets, etc using the supplied account card.  The SIM card has to make at least 1 
phone call in every 6 month period, and so the system has been programmed to ensure that a 
call is made regardless of how many texts it has sent.  This call is made to the speaking clock 
and is to ensure the SIM card remains registered to the network provider.  Each data upload 
costs between 10p and 25p, depending on how many channels are being logged. 
 

1.3 Safety Precautions 
The following safety precautions must be observed during all phases of the operation, usage, 
service or repair of the Text Alert Alarm System. 
 
When in hospital or other health care facility, observe the restrictions on the use of mobiles.  
Switch the Text Alert off, if instructed to do so by the guidelines posted in sensitive areas.  
Medical equipment may be sensitive to RF energy. 
 
The operation of cardiac pacemakers, other implanted medical equipment and hearing aids can 
be affected by interference from cellular apparatus placed close to the device.  If in doubt 
about potential danger, contact a physician or the manufacturer of the device to verify that the 
equipment is properly shielded.  Pacemaker patients are advised to keep their Text Alert system 
away from the pacemaker, while it is on. 
 
Switch off the Text Alert before boarding an aircraft.  Make sure it cannot be switched on 
inadvertently.  The operation of wireless appliances in an aircraft is forbidden to prevent 
interference with communications systems.  Failure to observe these instructions may lead to 
the suspension or denial of cellular services to the offender, legal action or both. 
 
Do not operate the Text Alert in the presence of flammable gases or fumes.  Switch off the Text 
Alert when you are near petrol stations, fuel depots, chemical plants or where blasting 
operations are in progress.  Operation of any electrical equipment in potentially explosive 
atmospheres can constitute a safety hazard. 
 
The Text Alert receives and transmits radio frequency energy while switched on.  Remember 
that interference can occur if it is used close to TV sets, radios, computers or inadequately 
shielded equipment.  Follow any special regulations and always switch off the Text Alert 
wherever forbidden, or when you suspect that it may cause interference or danger. 
 
IMPORTANT! 
The Text Alert operates using radio signals and cellular networks cannot be guaranteed to 
connect in all conditions.  Therefore you should never rely solely upon any wireless device for 
essential communication. 
 
Remember, in order to make or receive calls, the Text Alert must be switched on and in a 
service area with adequate cellular signal strength. 
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2 Hardware 

2.1 Inputs and Outputs 
The system is supplied as with up to 6 analogue / digital inputs, 2 additional digital inputs, 4 
digital outputs, and 4 Text Message Alarms which can be sent to up to 4 mobile phones.  The 
unit comes complete with a SIM card which will have been activated with the phone network.  
The unit can also be supplied with an optional PIR sensor.   

2.2 General 
It is important that the system is put into use within 6 months of receipt as the SIM card may be 
deactivated after this time if it has not been used.  The SIM card is supplied with a credit 
balance of £1.  It is advisable to add credit to the SIM as soon as possible. 

2.3 Installation 
The unit needs to be opened by unscrewing the 4 screws in the corners of the front panel.  The 
box divides into 2 parts.  The main circuit is located behind the front panel, and the connection 
terminals are found on the panel at the rear of the box. 
The two sections are joined by a ribbon cable which can easily be unplugged from the rear 
connection panel by opening the 2 side flaps on the connector and pulling the plug out of the 
socket.  The terminations on the rear connection panel are detailed below: 
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If additional PIR sensors are connected in series, all of the sensors keep the + and – terminals 
wired as above.  Input 8 on CON9 is wired into the first PIR’s ‘N’ terminal.  The ‘C’ terminal 
from this PIR is then wired into the next PIR’s ‘N’ terminal.  The ‘C’ terminal of the last PIR 
sensor is then wired into the GND terminal on CON9 to complete the circuit. 

2.3.3 Analogue / Digital Inputs 
The analogue / digital inputs are connected on terminals CON2 to CON7.  The inputs must be 
configured using the handbag links as shown below.  There are 3 options available.  In addition a 
24V supply is available on the leftmost terminal for use to excite 4-20mA or similar transmitters. 
 

Handbag Links  
  

Input Type L1 L2 L3 
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0 - 24V 
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3 Software 

3.1 GSM Data Software PC Installation 
Insert the GSM DATA CD into the CD-ROM drive on your computer and close the CD tray.  The 
software should run automatically.  If not, locate the CD-ROM drive in ‘My Computer’ and run 
the program Setup.exe.  The software will be installed to a default directory location, unless 
you select otherwise.   

3.2 GSM Data Logger Software 
Run the program GSM Data Logger.  A window will appear briefly while the software loads.  The 
main window screen appears showing the Summary page of the current configuration.   

3.2.1 Summary Page 
The summary screen has 6 sections to it showing details about the attached unit, including 
name, access code, password and version, phone network details, registered telephone 
numbers, together with the configuration of each of the optional input channels, optional output 
channels and text messages.  The entire configuration can easily be seen from this screen; 
however, the configuration cannot be altered from this viewpoint.  To change any of the details, 
you need to select one of the Tabs across the top of the window, selecting Inputs, Outputs, 
Messages or Miscellaneous.  
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3.2.2 Inputs 
Selecting the Inputs Tab displays the current configuration of Input 1 as well as showing tabs for 
each of the other 7 inputs.  The input may be displayed as ‘Not Used’; this can be altered by 
selecting ‘Analogue Input’ from the drop down list next to the ‘Type’ label.  This displays the 
various options and trigger levels for this input.  All the inputs are scaled from 0 to 100%.  The 
input can be given a unique name with up to 15 characters to help identify it in the Output and 
Message sections.  The logic functionality of the input can be inverted if required, and the 
analogue reading can be averaged over the last 4 readings to help reduce noise on the signal.   
 

 
 

Each input has selectable levels which the input signal is compared with to produce high and low 
level alarms.  For example by default the configuration is for a Low Logic Level of 0.0 and a High 
Logic Level of 50.0%.  If the input value is less than 50% the logic value is 0, but if the input rises 
equal to or above 50% the logic value of the input becomes 1.  This is illustrated on the graph 
beside the configuration.  The yellow area of the graph is where the input is at a logic 1 level 
and the white area is at logic 0.  A more complex comparison is possible for example by changing 
the low logic value to 20% for example.  The illustration above shows how the graph to the right 
now indicates that if the input value drops below 20% the input will also be at logic 1 level. 
 
Inputs 7 and 8 are digital inputs and so only produce logic 1 or 0, and have no analogue input 
value.  The logic can be inverted from the drop down box.  Again a graph to the right of the 
configuration shows how the logic works, including the hysteresis.  Basically the input is at logic 
0 until the input signal causes the internal voltage to reach 80% of its range.  The input stays at 
logic 1 until this same signal is reduced to 20% of its range.  This hysteresis helps the system to 
reject noise or ‘jumpy’ signals. 
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3.2.3 Outputs 
Pressing the Outputs Tab allows the output functions to be edited.  New Tabs are displayed one 
for each of the 4 optional digital output channels.  Each output can be configured as either an 
Input Logic Evaluation or an Analogue Input Evaluation. 

3.2.4 Input Logic Evaluation 
In this mode the output can be energised based on the logic value of each of the analogue 
inputs.  The screen allows the output to be named for identification.  The output can be 
switched on or off based on up to 3 logic expressions.  The logic function is selected using the 
small rows of eight boxes, representing each of the inputs.  So for example selecting the box 
labelled 1 on the upper row 1, means that output 1 will be switched on if analogue input 1 is in a 
logic 1 state.  However, ticking the box below this on row 0 in position 1 means that the output 
will be switched on if analogue input 1 is producing a logic 0 value.  More than one input can be 
selected here to produce conditions such as if inputs 1 and 2 but not 3 are active.  To the right 
of the rows of small boxes, a logic expression is produced depending on which inputs have been 
selected.  In addition there is the ability to add two additional logic expressions which are 
‘OR’ed with the first. 
 

 

3.2.5 Analogue Input Evaluation 
The output can also be triggered as a result of the value of any of the 6 optional analogue 
inputs.  It can be turned on or off when one or two inputs raise or lower to a certain value.  This 
is easily selected using the drop down selection boxes. 
 
Each of the outputs can have an Expiry Delay set which means that it cannot be re-triggered for 
a period of time.  In addition if an Expiry Delay is set, the unit can also have a Trigger Delay, 
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which is a period of time during which a trigger condition must be maintained continuously 
before the output is allowed to change. 

3.2.6 Messages 
The messages are almost identical in operation to the digital outputs.  There are two modes of 
operation, using either Input Logic Evaluation or Analogue Input Evaluation.  The logic details 
are the same as for digital outputs above.  There has to be an expiry time associated with each 
text message to avoid sending too many unnecessary messages and wasting the mobile phone 
account credit.  A trigger delay can also be set as described in the output section above.  The 
text message can be sent to any or all of the 4 registered mobile phone numbers, using the 
selection boxes at the bottom of the screen. 
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3.2.7 Miscellaneous 
The Miscellaneous screen shows a range of options regarding the operation of the unit.  The first 
section allows you to enter up to 4 mobile phone numbers to be registered with the system.  
This means that any text messages can only be sent to any of these 4 numbers.   In addition only 
any of these 4 numbers can be used to send messages to the unit asking for status information 
etc.  Each phone number can also be selected to have a text message sent to it if the clock 
resets and causes disruption to any currently active delays or if the power supply fails.  The first 
number is that of the base station, which must be included for the Datalogger to know which 
number to use to upload the data. 
 

 
 

The unit can have a name given to it in the box at the top right of the screen.  In addition the 
mobile phone access Password is set here together with the front panel Access Code.  The 
Access Code must consist of zeroes and ones, and can have between 1 and 16 key presses.  The 
Access Code is used to switch the unit between ON and OFF mode. 
 
Below this details on the mobile phone network must be entered.  The Disconnection Days Limit 
is the number of days that the phone will stay active on the network if it hasn’t dialled a 
number.  For the supplied Vodafone system, this is 180 days, and so the number 175 is entered 
here to force the system to make a call after 175 days to ensure the network link is maintained. 
 
The Balance Phone Number is entered here to allow the system to phone the network provider 
to find out the current balance on the account. For the supplied Vodafone system this is set to 
*#1345#. 
 
The Time Delays box allows you to enter time delays.  The ‘Power Failed’ message delay sets the 
time after a power failure occurs, before the unit sends a Power Failed text message.  This could 
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be set to 30 minutes to help avoid unnecessary alarms.  The ‘Power Now OK’ will delay the 
sending of a Power Restored message until a specified time has occurred without another 
failure.  This will again avoid unnecessary alarms.  A typical value may be 10 minutes.   
 
The Alarm Set Delay is important to avoid false intruder alarms.  This is the time delay after 
switching the system from OFF to ON mode before an alarm will be triggered.  This allows the 
user time to leave the protected area and lock the door, before the system fully activates.  
 
The system can log the values of up to six inputs, selected by ticking the associated check 
boxes.  The values on the chosen inputs are logged every minute when ‘Log Every Minute’ is set 
to ON. 
 
The changeover time is the time of day the Datalogger dials in to the base station to upload the 
last 24 hours worth of data.  If it is unable to get through it will continue logging new data whilst 
retaining the old data for up to 8 hours.  The old data can be requested with a text message 
during this 8 hour window. 
 
When multiple dataloggers are configured to upload to the same base station, it is sensible to 
space out the changeover times to reduce the likelihood of 2 dialling in at the same time.  At 
least 3 minutes is recommended since a data call can take up to 90 seconds.  
 

3.2.8 Read Input Values 
The Read Input screen is accessed through the ‘Link-> Read Inputs’ menu option.  This screen 
allows the computer to read the actual analogue input values together with the logic state of 
each channel.  The computer has to be connected to the Text Alert with a standard RS232 
communications lead. The Text Alert has to be placed into PC LINK mode from the front panel as 
described in Section 5.  Pressing the Read key in the new window will cause the computer to 
take a new set of readings from the Text Alert.  A typical display is shown below: 
 

 

3.2.9 Programming the Text Alert 
The Text Alert is programmed using the Link->Program menu option.  After the configuration has 
been made within the program, it is always advisable to save the configuration before 
programming.  The Text Alert must be placed into PC LINK mode as described in Section 5.1.4, 
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and a standard RS232 communications lead connected between the Text Alert and the PC.  It is 
also necessary to set which COM port you are using on the PC.  This is altered using the Comms-
>Comport menu option.  Once this has been set, select the Comms->Program menu option and 
the PC will send the configuration into the Text Alert.  The programming will take a few seconds 
to complete.  The Text Alert is then ready to use.  If logging is enabled it will prompt you to 
reset the log values already stored in memory. 

3.2.10 Reading the Text Alert 
The Text Alert configuration can be read using the Link->Read Configuration menu option.  Once 
again the Text Alert has to be placed into PC LINK mode and a standard RS232 communication 
cable attached.  Ensure that any configuration in the Text Alert software has been saved, and 
then select the Comms->Read Configuration menu.  The reading will begin and after a few 
seconds the configuration will be shown on the computer. 
 

3.2.11 Reset Log Input Data 
 

This screen allows you to reset the log data in memory and is usually performed after a 
Datalogger has been re-programmed.  If log data is not reset, the next data upload may contain 
some invalid readings, particularly if the changeover time was changed during programming. 
 

3.2.12 Program Time and Date 
 

It is important that the Text Alert knows the correct time and date, otherwise it will upload data 
at the wrong time.  Make sure the PC being used has the correct time and date on it before 
programming the time and date. 
 

3.2.13 Get Network and Balance Info 
 

The balance and time of network call information can be retrieved using this menu option.
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3.3 Central PC GSM Data Receiver Software 
 

This program is used to control the base station Siemens GSM modem so that data can be 
received from the Datalogger. Data can only be received when this program is running. 

3.3.1 Start Up 
Connect the modem to the pc with the comms cable. Switch the modem on.  It takes a few 
seconds to connect to the network and once connected it will briefly flash its led every 3 
seconds. Start the GSM Data Receiver Program (Start->GSM Data->GSM Data Receiver). After a 
few seconds it should display these messages: 
 

10/09/2005 15:04:07 Log file opened when program started: Sep05datalog.log 
10/09/2005 15:04:07 Commencing modem initialisation 
10/09/2005 15:04:10 Initialisation complete, waiting for data 
 

If the third message is not displayed, check the com port is set up correctly using the menu 
options Modem> Change Com Port. 

3.3.2 Normal Operation 
Every day at the scheduled upload time the Datalogger dials in. The call is answered and data is 
saved in the installation directory which by default is: 
 
C:\Program Files\GSM Data  
 
It is stored in “comma delimited” format, enabling the file to be opened in Excel or other 
spreadsheet program. It takes the form of the Datalogger name then the date of the first reading 
in the file. 
 
For example if the name of the Datalogger is “Log Unit 1” and the date of the first reading is 8th 
Sept 2005 the file will be called: 
 
LogUnit1_08092005.csv 
 
If the Datalogger was not able to dial in (because the receive modem was not switched on for 
example), the Datalogger will continue to store new data for eight hours, whilst still retaining 
the old data. In order to get the Datalogger to upload the old data a “Log request” message will 
need to be sent to the unit within eight hours of the originally scheduled upload. 

3.3.3 Change Password 
The Change Password screen is accessed through the ‘File-> Change Password’ menu option.  
The default password is PASSWORD which can be changed by following the instructions on 
screen. 
 

3.3.4 Records 
The Records screen is accessed through the ‘File-> Records’ menu option after successfully 
entering the password. A record can be created for each datalogger that might require a text 
message to be sent to it. Use the Add Record button to enter the Name, Password and Number 
of each datalogger. The password is case sensitive. It is recommended that numbers are entered 
in international format (for example 07799 123456 should be typed in as +447799123456 with no 
spaces in between).  Records can be edited later if any changes are required. 
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3.3.5 Send Message 
A text message can be sent from the base station modem to the Datalogger. This is achieved by 
choosing ‘Log-> Send Message’ using the drop-down menus and entering the password. Choose 
the destination of the message from the dropdown box.  The corresponding number will be 
retrieved. Choose the type of message and click Send to send the message.  
 
Messages that can be sent to the datalogger are documented in section 4, but some extra details 
are given here. 
 
• Log Request 
 
Usually within a minute the Datalogger will dial in. The call is answered and the data is saved in 
exactly the same way and location as normal. 
 
The data received and the format of the filename depends on when the Datalogger receives the 
“log request” message. If it was within eight hours after a scheduled upload that failed, the old 
data will be saved and the filename will be  
 
LogUnit1_08092005.csv 
 
If the last scheduled upload had been successful, or if it is more than eight hours after the last 
scheduled upload, the letters Sp will be added to the end of the filename to enable it to be 
distinguished. Our example above would be called:  
 
LogUnit1_08092005Sp.csv  
 
Data in this file will only be a portion of the day, with valid readings up to the present minute. 
 
• Switch on Log Upload to this modem 
 
This message will change the base station number to that of the modem that sent the message, 
which also has the affect of switching on log uploading if it had previously been switched off. 
 
• Switch off Log Upload 
 
This message will delete the base station number from the datalogger, which has the affect of 
switching off log uploading because the datalogger will now have no number to upload the log 
data to. 

3.3.6 Store Raw Data 
The data received by the modem can be stored in an unprocessed state by selecting this menu 
option (so that there is a check mark beside it).  
 
This option is available primarily for troubleshooting and can be ignored for normal use. 

3.3.7 Get Balance 
The remaining balance on the sim card can be requested. This is achieved by choosing ‘Modem-> 
Get Balance’ using the drop-down menus. Since this is a modem command, ATD must be put in 
front of the Vodafone balance request string *#1345# to give ATD*#1345# 

3.3.8 AT Command 
AT commands can be sent to find out more about the status of the modem. For example 
AT+COPS? finds out the network the modem is connected to and AT=CSQ will give an indication 
of signal strength.  This option is available primarily for troubleshooting and can be ignored for 
normal use.  
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3.3.9 Advanced 
This gives access to the timeouts used when the modem performs various tasks.  This option is 
available primarily for troubleshooting and can be ignored for normal use. 

3.3.10 GSM Data Receiver Log File 
 
All transactions displayed on screen are also written into a log file, stored in text format in the 
following location: 
 
C:\Program Files\GSM Data  
 
The filename takes the format of the month, year then the word ‘datalog’, for example: 
 
Sep05datalog.log 
 
 

3.4 Uninstalling the Software 
To uninstall the software, go to the Windows Control Panel and select Add/Remove Programs.  
The GSM Data software will be listed. Highlight this item and press Remove.  Windows will 
automatically delete the program, although the directory with any data files will remain.  These 
can be deleted using the standard Windows Explorer or through ‘My Computer’. 
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4 Controlling the Text Alert from your mobile phone 
 

4.1 Using the Password 
It is possible to register your mobile phone with the unit if the Password is known.  To do this 
you need to send a text message from your mobile phone to the Text Alert unit selecting one of 
the 4 phone number locations.  Be careful not to overwrite an already stored number.  So for 
example if you wish to add your phone to location 1 and the password is “yellow” send the 
following text message from the phone you wish to register: 
 

yellow A1 
 

The password is case sensitive so take care when typing the message.  The Text Alert will add 
the mobile phone number which is automatically added to the text message into memory 
number 1.  Simply change A1 into A2, A3 or A4 for the other phone number memories. 
 

4.2 Available Text Commands 
Once your phone has been registered with the unit the following commands become available.  
Each of the commands is detailed below: 
 
 
A1 Add Phone to System 
S1 Request Status Message 1 
S2 Request Status Message 2 
NP Change Password 
CD Change front panel button Access Code 
D1 Delete Phone from System 
OFF Put System into OFF Mode 
ON Put System into ON Mode 
RESET Reset System 
O1H Force Digital Output ON 
O1L Force Digital Output OFF 
O1P Allow Digital Output to follow program 
LOG Request oldest available Data Log 
 
 

4.2.1 A1 - Add Phone to System 
Replace the word Password below with the actual unit’s password. 
 

Password A1  
 
Put the sending phone number into memory location 1.  Note this will overwrite the number 
already stored in this location.  Use A2, A3 and A4 for the other memory locations.  Please 
ensure that the mobile phone you are using is your own and do not use any internet SMS Text 
Messaging services for this command as your security could be compromised.  Please note that 
location A1 must be the telephone number of the Base Station. 
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4.2.2 S1 - Access Status Message 1 
 

Password S1  
 

Request Status message 1 to be sent to your phone.  The message sends the following 
information: 
 
The Name of the unit   Up to 15 letters 
The current operating mode   ON or OFF 
Power supply status    OK or PF if the power has failed 
The value of the analog inputs 0 - 100% 
The state of the 2 digital inputs HI or LO 
The logic values of the inputs  0 is condition False 
   1 is condition True 
The status of the digital outputs   

H is ON 
 L is OFF  
 OK output is in this state 
 DE a time limit is active and the output cannot change  
 NU not used  
 FO output has been forced into the current state  
 TR means that the output has been triggered, but a trigger delay is active after which the 

output will change state 
The status of the text messages    

OK message is waiting for the trigger condition to occur 
 DE message sent to all phones and time limit is active 
 DN has been sent to some but not all of the required phones  
 NU not used  
 TR means that the message has been triggered, but a trigger delay is active after which 

the message will be sent 
The balance of the phone account 
 
So a typical message could be: 
 
LOG UNIT ON,OK I:1=10.6 2=63.9 3=30.5 4=40.8 5=78.7 6=100.0 7=LO 8=NU L:11100000 O:1=H.OK 
2=H.FO 3=L.OK 4=L.NU M:1=OK 2=DE 3=DN 4=NU B:#10.82 
 
This message indicates that the unit is called LOG UNIT 
The system is in ON mode 
The power supply is OK. 
The analog inputs are at values 10.6, 63.9, 30.5, 40.8 78.7 and 100.0 
Digital input 7 is off (LO) and 8 is not used (NU) 
The logic levels for each of the inputs are ON, ON, ON, and the rest are OFF. 
The outputs are ON (H), FORCED ON, OFF (L), OFF and not used (NU). 
 
The text messages are in the following conditions: 
Message 1 is OK (waiting for condition to trip). 
Message 2 has been sent to all required phones and cannot be resent until the time expires. 
Message 3 has not been sent to all phones yet, but it will continue to try and send the 
information until the time expires. 
Message 4 is not used. 
The balance of the phone account is £10.82 
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4.2.3 S2 - Access Status Message 2 
 

Password S2  
 
Request Status message 2 to be sent to your phone.  This message sends the following 
information: 
 
The Name of the unit   Up to 15 letters 
The current operating mode   ON or OFF 
Power supply status    OK or PF if the power has failed 
The 4 registered phone numbers Telephone number or ‘Empty’ 
The software version number e.g. D.02 
The balance of the phone account 
 
A typical message could be: 
 
LOG UNIT ON,OK 1:+4412345678 2:+4412346789 3:+4412347890 4:EMPTY D.01 B:#10.38 
 

4.2.4 NP - Change Password 
 

Password NP Newpassword 
 
The current password is changed to Newpassword.  Take great care with this command as from 
this moment the new password will have to be used to access the system. 
 

4.2.5 CD - Change Front Panel Access Code 
 

Password CD NewAccessCode 
 
The current access code is changed to NewAccessCode.  Take great care with this command as 
from this moment the new access code will have to be used to change modes on the system.  
The Access Code is a string of numbers 1 and 0, which set the order that the front panel buttons 
marked 1 and 0 have to be pressed to change operating mode on the unit.  The length of the 
Access Code is from 4 presses up to a maximum of 16 presses.   
 
An example of this is: 
 
 Password CD 100110  Which changes the Access Code to 1,0,0,1,1,0 
 
When sending the access code do not enter any spaces or other characters between any of the 
numbers, or the code will be incorrect.  The code will not change if there are less than 4 
numbers entered. 
 

4.2.6 D1 - Delete Phone from System 
 

Password D1  
 
Delete the phone number in memory location 1.  Use D2, D3 or D4 for other memory locations. 
Please note that D1 will delete the base station number, stopping log data uploads to the base 
station. 
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4.2.7 OFF - Put System into OFF Mode 
 

Password OFF   
 
Put the Text Alert into OFF mode. 
 

4.2.8 ON - Put System into ON Mode 
 

Password ON   
 
Put the Text Alert into ON mode.  Please note that if your system has an Alarm Set Delay 
configured, this will be ignored if the system is put into ON mode with a text message.  Please 
ensure that you are not in the protected area. 
 

4.2.9 RESET - Reset System 
 

Password RESET 
 
Reset all outputs, reset all outputs to default condition, reset all output and message expiry 
dates. 
 

4.2.10 O1H - Force Digital Output ON 
 

Password O1H  
 
Force output 1 to switch on; use O2H, O3H and O4H for other outputs.  Note that O1H is made 
using the capital letter O, not zero. 
 

4.2.11 O1L - Force Digital Output OFF 
 

Password O1L   
 
Force output 1 to switch off; use O2L, O3L and O4L for other outputs.  Note that O1L is made 
using the capital letter O, not zero. 
 

4.2.12 O1P - Allow Digital Output to follow program 
 

Password O1P   
 
Force output 1 to follow the program, all expiry and forced restrictions are removed.  Note that 
O1P is made using the capital letter O, not zero. 
 

4.2.13 LOG – Request Data Log from the System 
 
This command allows you to request the Datalogger to upload data readings to the base station.  
Normally this will be data from the changeover time until the time it received the LOG request 
text message. 
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If the Datalogger receives the message in the 8 hours following a failed attempt by the 
Datalogger to upload the data, it will send the 24 hours worth of data preceding the last 
changeover time.  Once this has been successfully uploaded (or 8 hours have passed) this text 
message will cause the newest log data to be uploaded. 
 

4.3 IMPORTANT NOTE 
Please ensure your password is kept secret, and think about changing the password on a regular 
basis to maintain security.  If your password and system telephone number are known, it will be 
possible for an intruder to switch off the system. 
 
It is recommended that messages to and from the system are not saved on your mobile phone, as 
these may contain the phone number and password of the system. 
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5 Using the Alarm 

5.1 Operational Modes 
The Text Alert has 3 operating modes, ON, OFF and PC LINK.  The unit will 
usually go into OFF mode after power is applied, unless the unit was 
running in ON mode when a power failure occurred, in this case the unit will 
immediately return to ON mode when the power is restored.  In addition 
there is a temporary Start Up mode.  Note that the datalogging function 
works the same way in ON or OFF mode. The Front Panel design is shown 
here: 
 

5.1.1 Power Up 
When the unit is powered on, the red PWR LED is lit.  The unit assesses the 
state of the internal battery and if it is uncharged the system will trickle 
charge the battery for 1 hour.  During this time both the red PWR LED and the 
Tx/Rx green LED will be lit permanently.  If the battery is not totally 
discharged but only holds a minimum level of charge, the system will 
boost charge the battery for 15 minutes during which time both the red PWR 
LED and the red ALM LED will be lit.  If after either of the charging c
system decides that more charging is required the system will just 
continue the charging cycle for another hour or 15 minutes.  If either of 
these charging cycles is required the unit will not respond to any key 
presses, text messages or communications.  When the battery charge is acceptable the unit will 
re-enter the last operational mode it was in before it powered down. 

ycles, the 

PWR 

TX/RX

ALM 

I/P 

 

5.1.2 OFF Mode 
The unit can be switched into OFF mode by pressing both front panel buttons for up to 1 second 
until the Green Tx/Rx LED lights, and then the user must start to enter the access code using the 
2 keys, O and 1, within 2 seconds and each subsequent digit within 2 seconds of the previous.  
Each key press will flash the RED power LED.  Once the code has been entered correctly, the 
unit will enter OFF mode.   
 
In OFF mode the unit will continue to read the inputs, but the outputs and the text message 
programming will be ignored.  Any triggered outputs or text messages will be reset to their 
default condition and the ALM LED will be switched off.  The user can still request status 
messages and force outputs and change phone numbers etc in this mode.  In OFF mode only the 
PWR LED flashes, but in the same format as ON mode.   
 

5.1.3 ON Mode 
The unit can be switched into ON mode by pressing both front panel buttons for up to 1 second 
until the Green Tx/Rx LED lights, and then the user must start to enter the access code using the 
2 keys, O and 1, within 2 seconds and each subsequent digit within 2 seconds of the previous.  
Each key press will flash the RED power LED.  Once the code has been entered correctly, the 
unit will enter ON mode.   
 
In ON mode the unit is monitoring it’s inputs, calculating the logic functions of these inputs, 
checking the programming of the digital outputs, switching the outputs on and off as required, 
monitoring the programming of the messages and sending any required text messages to each of 
the registered phones.  In addition it is monitoring for any incoming messages from registered 
phones with respect to status messages, forcing outputs, changing phone numbers etc.  Whilst in 
ON mode the unit flashes both the PWR and Tx/Rx LED’s briefly every 2 seconds if the main 
power supply is OK, or every 4 seconds if the unit is being powered from the internal battery 

CODE 

PC

PC 

SMS 

ALERT 
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back up.  However, if the unit has not been able to establish a mobile phone link, the LED’s will 
double flash each time. If any of the digital outputs or text messages are triggered, the unit will 
switch on the ALM LED whilst the alarm condition is still triggered. 
 

5.1.4 PC Link Mode 
The unit can be switched into PC Link Mode only from OFF mode.  To do this the user must push 
the lower ‘O’ button for 3 seconds and the unit will switch into PC LINK mode and the PC LINK 
LED on the front panel will light by itself, all other LED’s will remain off. 
 
In PC LINK mode the unit is purely looking for programming information coming through the 
RS232 communications port.  The user needs to connect the unit to a PC with a standard 
communications cable and run the supplied GSM Datalogger PC software.  The unit can then be 
programmed as required.  Once programmed the unit is returned to the OFF mode again by 
pressing the lower ‘O’ button for approximately 3 seconds, until the PC LINK LED switches off.  
The unit is then in OFF mode and needs to be switched into ON mode for full functionality as 
described above.  The unit will not stay in PC LINK mode unused for more than 2 minutes, after 
which time it will automatically revert to OFF mode.  This allows the unit to conserve power. 

5.1.5 Shutdown Mode 
To shutdown and switch off the Text Alert, the unit must have its power supply switched off or 
disconnected.  The unit must then be put in OFF mode.  Afterwards, Switch ‘1’ on the front 
panel must be pressed for 5 seconds until the PWR, Tx/Rx and ALM LED’s are lit.  Release the 
switch ‘1’ and wait for the LED’s to extinguish.  The unit must be in Shutdown Mode before the 
front cover is removed. 

5.1.6 No Power Mode 
If the main power supply fails, the unit enters internal battery back up mode.  In this state the 
digital outputs will all be switched off to conserve power.  A Power Fail message will be sent to 
any phones registered for Power Fail messages after the programmed power fail time delay has 
occurred.  Any new text message alarms will still trigger the unit to send the text message in the 
same way as normal.  The unit can continue to operate in this low power mode for up to 24 
hours before the internal battery will fail.  When the system detects that the internal battery is 
about to fail, a final message will be sent to phones registered for Power Fail messages, to 
inform them that the unit is about to switch off.  It is recommended to have the Text Alert send 
the Power Fail alarm message to at least one phone so that action can be taken to try and 
correct the main power supply failure.  After a power is restored following a power failure, the 
unit will return to the same mode it was in when the power failed.  So if it was in OFF mode it 
would remain in OFF mode when the power recovers.  Likewise it would return to ON mode, if it 
was in ON mode when the power failed. 

5.1.7 Error Mode 
If the unit decides that it has an error which it cannot correct, the red ALM LED flashes on for ½ 
sec then off for ½ sec continuously.  The unit will not perform any other tasks during this time.  
This mode indicates that there is an error with the programming of the unit.  The unit needs to 
moved to PC LINK mode by pressing the ‘O’ button for about 3 seconds until the PC LINK LED 
lights.  The unit should then be reprogrammed through the serial port.  It should then be 
possible to change back to OFF and then ON mode for the unit to function. 

5.2 Changing the SIM card 
The SIM card can be removed very easily.  The unit MUST be put into SHUTDOWN mode as 
described above, before any of the following is performed.  The unit needs to have the front 
cover unscrewed.  Once opened the front panel can be disconnected from the back plate by 
opening the side levers on the cable connector linking the two sections.  Once removed, looking 
inside the front cover assembly the SIM card socket can be found off to the right of centre just 
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before the phone and battery circuitry.  The SIM card holder can be removed by sliding the 
yellow push switch on the side.  The SIM card and holder will be pushed out of the connector.  
The plastic holder can be turned over to reveal the SIM card inside.  If a SIM card is not present 
simply insert the SIM card in this plastic holder, and then slide the holder into the connector on 
the circuit board.   

5.3 Replacing the Battery 
Contact your supplier if you feel that the battery may need changing.  The battery is a specially 
designed battery for this type of mobile phone circuitry.  DO NOT use any other battery as this 
could damage the unit beyond repair. 

5.4 External Aerial 
An optional external aerial can be fitted to the unit.  Please contact your supplier for more 
details. 

5.5 Which Mode is the Text Alert in? 
Simply phone the number of the Text Alert system using any voice phone and the unit will beep 
to indicate which mode the unit is in as shown below: 
 
 OFF Mode:  1 beep high, then 2 beeps low 
 ON Mode: 1 beep high, then 1 beep low 
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6 Specifications (@ 25°C) 
 
Operating Temperature 0 to 55°C (Storage -20 to +85°C) 
Operating Altitude Sea Level to 2000m 
Humidity 0 – 90% RH 
Power Requirements 11.1 to 15V dc 
Current Consumption 10.7 mA @ 12V dc (typical under minimum load) 
 110.0 mA @ 12V dc (typical under maximum load) 
 400.0 mA peak whilst fast charging batteries 
Temperature Stability 100ppm / °C 
 
Input Impedance 
 Current Input (0 – 20mA) 160 ohms 
 Voltage Input (0-10V)  1 Mohm  
 Voltage Input (0-25V)  2.6 Mohm 
 
Output Relay Rating 
 Maximum Voltage 60VDC 
     125VAC 
 Maximum Current 1A @ 24VDC 
     0.5A @ 125VAC 
 
Phone Network 
Frequency Bands Dual Band EGSM 900 & GSM 1800 (GSM Phase 2+) 
GSM Class Small MS 
Transmit Power Class 4 (2W) for EGSM 900 
 Class 1 (1W) for GSM 1800 
Antenna Design 50 ohm antenna interface 
 
 
Dimensions 210mm (w) x 112mm (h) x 50mm (d) 
Connections Screw Clamp with pressure plate 
Conductor Size 0.5 to 4.0mm 
Insulation Stripping 12mm 
Maximum Terminal Torque 0.4Nm 
Weight 600g 
 
CE Conformity 
R&TTE Directive 1999/5/EC 
LVD 73/23/EEC 
EMC Conformity in accordance with directive 89/336/EEC  
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7 Notes 
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